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1 2012 15 %

462 67.6 % 2,3

300 

senile plaque

neurofibrillary tangle neuropil thread

�� A�

Braak stage / / /

4-6 7
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8  

9 A��

A��

A��

APP 10 1 11,12 2 13

A��

APP A673T A�� 14

17 FTDP-17 Frontotemporal dementia and 

Parkinsonism linked to chromosome 17 15, 16, 17

FTDP-17 A��

 

A�� APP ��   ��

A��
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40 A���� �� A����

	� C A��42

18  

A�� 128 

15 

A�� 19

5 Mini-Mental State Examination Clinical 

Dementia Rating scale 3 

10 A��

FDG-PET 764 

default mode network A��

20  

A�� A��

21 A��

22 A��

20-30 %
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in vivo

23, 24 A��

in vivo 25

A�� A��

A��

A�� 26 A��

 

A�� perforant pathway

1

APP

A��

27

A�� 28-30
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APP A�� 31

A��  

2

13.5 ms 32 C128S, 

D156A Stabilized step function opsin SSFO 1 

30 

33 1 A��

SSFO  

 

SSFO

473 nm 4 mW 2 4 in vivo

A�� 24 %

A��
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A��

A�� in vivo

A��  
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1. A7  

APP A7

A7 Thy 1.2

K670N/M671L

T714I APP 34

2 A�� N �� APP

A�� A�� C

�� A��42

�

Thy 1.2 pTSC21K Novartis 

Pharma. AG 2 APP695 cDNA

trangene C57BL/6J BDF1

Not transgene DNA

CD-1
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SPF specific pathogen free  

A7 APP 1.4 APP A��42

E15.5-E17.5 5-7 

A�� A��42 A��40 3.5 

  

9 A��

A�� 11 

A�� A��

 

2. AAV1  

2-1. AAV  

pAAV-CaMK 
-SSFO-EYFP Stanford Karl Deisseroth

SSFO-EYFP pBluescript-CaMK


-GFP-WPRE GFP

CaMK 
-SSFO-EYFP-WPRE AAV

pFBAAV-CAG-EGFP-WPRE CAG-EGFP

pFBAAV- CaMK 
-SSFO-EYFP-WPRE

EYFP pFBAAV- EYFP-WPRE  
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2-2.  

pFBAAV DH10Bac E.coli pFBAAV

bacmid DNA bacmid DNA

Blue/White bacmid DNA Sf9

Cellfectin Life Technologies

SSFO qPCR

SSFO-EYFP 1x108 pfu/mL EYFP 8x107 pfu/mL

LightCycler3 Roche DNA Y genome copy/mL

PEG-ProK Y/100 pfu/mL  

 

2-3. AAV  

RepCap1

MOI = 2 Sf9 27 3 

rAAV1 60 20 

AAV AVB Sepharose GE

Amicon Ultra 100K-15 Millipore

qPCR SSFO-EYFP 3.5x1013 genome copy

gc /mL EYFP 3.4x1013 gc/mL LightCycler3 Roche 3

-80  
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3. AAV  

3-1.  

CLOSE UP 35  

3-1-a.  

500 mL ��12 mm

50 mL 30 

50 mL 30 2 

100 % 100 mL 30 70 % 

1 

50 mL

 

 

3-1-b. PDL  

1 24 well

20 mM Tris-HCl 25 �g/mL -D- 354210 BD Bioscience

1 150 �L  

-D- 3 
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3-1-c.  

15-16 

Hanks’ Balanced Salt Solution HBSS, Ca, Mg free 14175

Life Technologies

20 % Fetal Bovine Serum FBS

HBSS 20 % 

FBS HBSS 15 mL 13 mL

HBSS 3 FBS 1 mL 137 mM NaCl

5 mM KCl 7 mM Na2HPO4 12H2O 25 mM HEPES pH 7.2

20 mg/ml 1 mL T1005

�6,000 BAEE units/mg protein, Sigma MilliQ 1 mg / 20 �L  

DNase 20 �L D5025 �2,000 Kunitz units/mg protein, Sigma

0.22 �m 10 

20 % FBS HBSS 10 mL

13 mL HBSS 3 

2 mL HBSS 12 mM MgSO4 7H2O DNase 20 �L

0.22 �m P1000 15 P200

10 20 % FBS

HBSS 10 mL 1,000 rpm 4 5 
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FBS medium 5 mL Neurobasal medium 21103 Life 

Technologies 10 % FBS 1 % / 1 % GlutaMAX

35050-061 Life Technologies

6-8 x 106 cells/mL 100 �L

20 

37 FBS medium 400 �L/well

well well well

Dulbecco's Phosphate-Buffered Saline Div 1 4 �M

Ara-C Neuronal medium Neurobasal medium 2 % B27 17504044

Life Technologies 1 % / 1 % GlutaMAX

 

 

3-2. AAV  

Div 4 5 

genome copy Div 26 4 % 

Paraformaldehyde PFA 10  
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3-3.  

Phosphate buffered saline PBS: 8 mM Na2HPO4

192-02815 2 mM NaH2PO4 196-02835 131 mM NaCl pH 7.4 5 

3 3 % Calf serum 0.2 % Triton X-100 1 mL/well

15 PBS 5 3 3 % 

Calf serum PBS 1

4 PBS 5 3 3 % Calf serum

Alexa IgG Life 

Technologies 2 �g/mL DRAQ5 DR50200 ImmunoChemistry 

Thechnologies 2.5 �M 1 PBS 5 3 

PermaFluor TA-030-FM Thermo scientific

 

 

4. A7 AAV  

C0073 400 mg/kg

70 %

2 %

502063 World Precision Instrument
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38 MP908-N

SZ61-60

942-B Kopf 900LS Kopf

0.05 mm Bregma

3.0 mm 4.5 mm NE120

 ��0.4 mm BC1401 Minitor 0.5 mm

3283 3M 10 �L

801N Hamilton KDS101 Kd Scientific

PG10165-4

World Precision Instrument

P-97 Sutter EG-400

100 �m 40 ° 

1.0 �L 10 %

Fast blue

2.5 mm 2-3 

1.0 �L 0.1 �L/ 4

10 6-0
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38 MP-916-N

4 12 23-24  

AAV1 CaMK 
-EYFP A7 EYFP

AAV1 CaMK 
-SSFO-EYFP A7 SSFO

 

 

5. A7  

4 

Bregma 3.0 mm 4.4 mm

1.0 mm

MFC_200/240-0.22_4.0 mm_ZF1.25_FLT Doric 2.25 mm

4 Super-Bond C&B

Sun Medical  
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6. in vivo  

6-1.  

5. 

Bregma 2.8 mm 0.5 mm

1.0 mm 38 ° 

1.3 mm 18-A

PEG-8

Eicom PED-8 Eicom AC-5

Eicom  

 

6-2.  

artificial CSF 1.3 mM CaCl2 039-00475

1.2 mM MgSO4 131-00405 3.0 mM KCl 163-03545 0.4 mM KH2PO4

169-04245 25 mM NaHCO3 191-01305 122 mM NaCl 1320-34

0.15 % BSA A9576 Sigma 0.1 �m PVDF

SLVV033RS Millipore aCSF

FEP ��0.25 mm Eicom A�� aCSF 2 

 BSA 1,000 kDa

PEP-8-02 EiCOM MilliQ 100 % 1 
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1,000 kDa

aCSF KDS101 Kd Scientific 1.3 �L/min

aCSF 1,000 kDa

ERP-10 Eicom Speed 30 1.3 �L/min

820Microsampler Univentor

400 mg/kg

1,000 kDa

Raturn BASi

24 0.25 mL 503-Q

QSP 4 1 30 

4  

A�� 473 nm

4 mW 2 24 A�� �� 9 

18-B  

 

7. A��  

1 M 17319-85
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1 A��

A��42 ELISA Human/Rat ��Amyloid 42 ELISA Kit Wako

A��42  

BNT77

100 �L/well

4 well

200 �L/well 5 

HRP Horseradish peroxidase BC05 100 �L/well

4 1 5 TMB

tetramethylbenzidine 100 �L/well 2 

100 �L/well

SpectraMax M2e Molecular Devices

OD: 450 nm  

 

8.  

1 

5 4 Master-8 A.M.P.I.

473 nm SDL-473-070 MFL Shanghai Dream Lasers



25 
 

MFP_200/240/900-0.22_1 m_FC-ZF1.25(F) Doric

CT-S ICM 207 x 138 x 70 mm 12 

23-25 1 

8230E ADCMT 5.5 mW

4 mW 2 473 nm, 4 mW, 2 

3-5 5  

in vivo

12 18-B  

 

9.  

c-Fos 90 

PBS 3 4 %  

PFA P001 TAAB PBS pH 7.4 7 Perista Pump

SJ-1211H ATTO 4 mL/

4 4 % PFA  
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10. c-Fos  

10-1.  

RBM-200C ASI

2-3 mm 7 KA-1000

70 % 90 % 99 % 2 056-06967

2 99 % overnight 242-00087

3 2 67 165-14051

3 2  x 2  + overnight

HYRAX S30 Zeiss 4 �m MAS

FF-904 50 

45 PS-53 Sakura Finetek 1 

37 

PM-401 Sakura Finetek 10 

100 �m 5  

 

10-2.  

3 99 % 99 % 90 %

80 % 70 % 2 5 
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0.125 % 088-07461

6.25 % 011-02035 0.025 % 

37233-30 25 % 075-00616

10 

10 0.2 % 1 % Y

051-06515 5 70 % 80 %

90 % 99 % 99 % 3 

1 0.12-0.17 mm HSR

10200  

 

10-3.  

10-2. H.E 5

1  

Microwave 10 mM 1.8 mM 030-05525

8.2 mM 203-13605

pH 6.0 100 mM 100 mM Tris-HCl 15504-020

Life Technologies pH9.2

10 4 10 
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Proteinase K 37 100 �g/mL Proteinase K Proteinase K 9034

Takara TS 50 mM Tris-HCl 150 mM NaCl, pH 7.6

6 10  

10 % Calf serum 26010-066

Life technologies PBS 30 

GFP c-Fos 0.1 % 

Triton-X100 194854 MP Biomedicals

1 TS 5 3 

10 % Calf serum 500 3 �g/mL

IgG BA-2000 Vrctor BA-1000 Vector

2 TS 5 3 HRP

avidin-biotin complex ABC elite PK-6100 1 

TS 5 3 220 �g/mL DAB 3,3’-Diaminobenzidine 

tetrahydrochloride 347-00904 Dojindo 0.012 % 081-04215

TS 5 5 

10 10 HSR
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10-4.  

BX51 CCD DP71

4080 x 3072 432 dpi ISO-200 TIF  

 

10-5. c-Fos  

c-Fos

 

/

%  

 

11. A��  

10. c-Fos

A��  

A��

Image J http://rsb.info.nih.gov/ij/ 100 �m
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5 10-4. 

x10 x4 Image J Freehand selection

hippocampal fissure

1/3

36 Analyze > Measure

Image > Adjust > Threshold

Analyze > Analyze particles A��  A�� /

x 100 A�� % 100 �m 5 

7  
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1.  

1 EYFP

3 SSFO-EYFP

SSFO EYFP 20 % EYFP

3  

 

2.  

2-1.  

4 

EYFP

GFP A11122 Life Technologies EYFP

Bregma 3.0 mm

4.0 mm

CA 2.5 mm GFP 3.0 mm
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6-A  

 

2-2.  

GFP

10.5 1 

EYFP 6 6 SSFO 6 5 3 EYFP 6 5 

SSFO 6 5 5 EYFP 10 10 SSFO 13 11 

5.5 5 EYFP 5 5 SSFO 4 4 12.5 

3 SSFO 6 5 

5 6-A  

 

2-3. c-Fos  

c-Fos K-25 Santa Cruz EYFP

1-3 %  

SSFO

100 % 6-B
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2-4.  

GFP c-Fos

SSFO

c-Fos

10.5 1 EYFP 6 6 SSFO 6 5 

3 EYFP 6 5 SSFO 6 5 5 EYFP

10 10 SSFO 13 9 5.5 5 EYFP 5 

5 SSFO 4 4 12.5 3 SSFO 6 

4 5 6-C  

 

3. OML A��  

A�� A��

A��burden  

A7

Thy 1.2

K670N/M671L A��

T714I A��42 APP

9 A��

A�� 11 
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A�� A7

A��burden 5.5 10.5 0 % 11.5 

0.8 ± 0.6 % 15.5 7.0 ± 3.4 % A�� 5.5 n = 6

10.5 n = 5 11.5 n = 4 15.5 n = 13 11

11.5 A��burden

 

10.5 1 

A�� 8

SSFO EYFP A��burden 0.1 % 

SSFO 0.04 ± 0.02 % 0.05 ± 0.02 %

p = 0.73 EYFP 0.13 ± 0.05 % 0.12 ± 0.08 % p = 0.86 Student’s 

t-test mean ± SEM 11  

3 

A�� 9

A��burden 1.0 % SSFO 1.3 

± 0.7 % 0.8 ± 0.1 % p = 0.52 EYFP 1.4 ± 0.8 % 1.2 

± 1.0 % p = 0.88 Student’s t-test mean ± SEM 11 1 3 

24 
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5 A�� 8 

EYFP

SSFO

10 3 

SSFO A��burden 24.0 ± 4.2 %

9.7 ± 2.5 % A�� p 

< 0.01 Student’s t-test mean ± SEM EYFP 14.0 ± 3.4 %

13.9 ± 3.9 % p = 0.98 Student’s t-test mean 

± SEM 11

A��  

A�� 15.5 OML

A�� 10 % 40 %  

A��

5 A��

5.5-10.5 EYFP 5 

SSFO 4 A��

SSFO 0.13 ± 0.1 %

0.21 ± 0.07 % EYFP 0.05 ± 0.02 % 0.41 ± 0.26 %

SSFO p = 0.55 EYFP p = 
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0.21 Student’s t-test mean ± SEM 13 A��

12.5-15.5 3 

SSFO 4 10.2 ± 1.6 % 14.2 ± 5.4 % p = 0.50 Student’s t-test

mean ± SEM 14 A��

 

 

4. A��  

A��

A�� A�� 10.5 5 

EYFP SSFO

A�� A��burden

SSFO 11.2 ± 2.8 % 10.7 ± 1.7 % EYFP

11.5 ± 2.1 % 9.1 ± 1.5 % SSFO EYFP

A�� SSFO p = 

0.88 EYFP p = 0.37 Student’s t-test mean ± SEM 12  

 

5. SSFO  

473 nm 4 mW 2 
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SSFO 1 3-5 

SSFO 15 EYFP

 

20-40 

10-20 

2 1 15 

15 1-1.5 5 

30-40 

running 5-10 

20-30 

37  

A�� 10.5 5 

SSFO

A�� A��

R2 = 0.0115 n = 9 16  
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6. A��  

A�� A��

APP � APP C

BACE1 beta-site APP-cleaving enzyme 1

A�� 10.5 5 

 

APP C A��

SSFO

EYFP

BACE1

17  

 

7. A�����  

4-7 3 A7  

12 

in vivo A��42
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A��42 3 100 %

18-C 9 

SSFO 63 % 95 %  21-105 % p = 

0.0124 Paired t-test 18-D EYFP

p = 0.10 Paired t-test SSFO 1.5 8 

20-30 % 3.5 A��42 100 %

SSFO n = 6 EYFP n = 4  
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1

A��  

2 A��

 

3 A��  

4  

 

 

1.  

A��

immediate early gene c-fos c-Fos

EYFP

1-3 % SSFO

100 %
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1 

c-Fos

38 SSFO

30 SSFO

c-Fos

c-Fos

A��

 

 

2. A��  

A7 A��

10.5 5 SSFO

A�� 24.0 ± 

4.2 % 9.7 ± 2.5 % p < 0.01 Student’s t-test mean ± SEM
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EYFP

A��  

A�� 10.5 1 3 

A�� 1

19 10.5 1 3 n 5-6 

n A7

1, 3, 5 APP

 

A��

5.5 5 

A�� SSFO 0.13 ± 0.1 % 0.21 

± 0.07 % EYFP 0.05 ± 0.02 % 0.41 ± 0.26 %

A��

1 19  

A�� A��

A��

A��  
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3. A��  

A�� in vivo

3 100 %

9 SSFO 63 %

p = 0.0124 Paired t-test A��

A��

A��

A�� A��

A�� 30 

GABAA

in vivo 3-15 

A�� 39

A��

A�� A��

A��

 

 

4.  
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10-20 

1-1.5 

Racine, R. J.

40 Stage 1

Stage 2 Stage 3 Stage 4

Stage 5 Pinel JP, Rovner LI.

Stage 6 Stage 7 Stage 8

41

Stage 1-3 Stage 4

SSFO Stage 3

SSFO

Stage 5-7

 

SSFO 1

SSFO 20 

mW 42
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SSFO

c-Fos

4 mW 2 SSFO

1 mm

43,44

 

Doric

4 mW

1. 
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A��

A�� A��
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